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1 Document History

Version | Date Changed by Description of changes

1.0 Nov 27, 2014 EFIS Team Initial Release

1.1 Dec 11, 2014 EFIS Team Added ‘and Training’ to URL description “NOTE: For
UAT and Training user’s only, use this URL:”

1.2 Dec 17, 2014 EFIS Team Removed “NOTE: For UAT and Training user’s only,
use this URL:” from pages 15, 25 and 34

1.3 Feb 11, 2015 EFIS Team Removed reference to ‘Child Care’ / ‘Board User’ to

make a generic Setup Guide




2 Description and System Requirements

2.1 Description

The following information describes the setup and configuration requirements that need
to be made to the end user workstation in order to use the Planning application for EFIS
2.0 correctly.

In this ‘User Setup Guide’ you will find the detailed step-by-step instructions and
location of software needed:

e to setup and configure a supported browser (either Internet Explorer 9 or Firefox
17)

e to setup and configure the Smart View (Microsoft Excel Plug-In) software on the
end user workstation.

2.2 User System Requirements

Client OS Browsers Exceptions and Additional Info

Windows XP Internet Explorer 9.x EXCEPTION: To work on Internet Explorer

Professional with and Firefox, Calculation Manager requires

SP3+ Adobe Flash Player v10+ to be installed.

Windows Vista with | Firefox 17.x ESR EXCEPTION: Internet Explorer 9.x or higher

SP1+ is not supported on Windows XP
Professional SP3.

Windows 7 (all SP EXCEPTION: Firefox 17.x ESR requires

levels included) Remote XUL Add-on

Apple Mac OS X

Release 10.6.x

Client Third Party Software

Vendor Version Exceptions and Additional Info

Microsoft Office 2007 (all SP levels
included) Office 2010 (all
SP levels included)

Adobe Acrobat Reader 9+
Adobe Flash Player 10+
Oracle Smart View (v 11.1.2.5.200) | Microsoft .Net Framework 4.5 required for Smart View.




3 Firefox setup

3.1 Recommended Version

Firefox v17 is the recommend version for use with Oracle Hyperion Planning.

Versions later than v17 (up to and including the current version — v32) may also work,
however, these versions are not officially supported by Oracle. If you already have v32
installed you may wish to try it first. If you experience any problems it is recommended
that you downgrade to v17.

3.2 Download Files

e The following files are required:
o Firefox Setup 17 and
o Remote XUL manager.
They are both located in this one file:

https://efis.fma.csc.gov.on.ca/Firefox/Firefox.zip

3.3 Install Firefox
After clicking on the above link, you can download and install the file or elect to install
the files without downloading them.

You may need to have Administrator rights to install Firefox. Please contact your local
IT support desk to provide the Administrator access.

3

File Download

Do you want to open or save this file?

F| Mame: Firefox.zip
Type: Compressed (zipped) Folder, 1&.5MB

From: efis.fma.csc.gov.on.ca

Cpen | | Save | | Cancel |

I [ | While files from the Intemet can be useful, some files can potentially
d harm your computer. i you do not trust the source, do not open or
= save this file. YWhat's the risk?



https://efis.fma.csc.gov.on.ca/Firefox/Firefox.zip

If you decide to save the file, the zipped file will be saved to your local computer and the
files will appear in your download folder.

-

MName Type Compressed size Passw
571 Firefox Setup 17.0 11esr Application 18,941 KE Mo
| remote_xul_manager-1.2.3-an+fn+... XPIFile 42KB MNo

Click on ‘Firefox Setup...’ file to select a location to extract the file to. The location
doesn’t matter, so you can accept the default if you choose.

- P T o T

(L) [ Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

CAUzers RO o curments\Fircfox(1]

Show extracted files when complete

[ Edract | [ cancer |

Click on ‘Extract’ to extract the file and install it. You will be prompted to extract both
files at the same time. Do so at this time.

Click on ‘Firefox Setup...’ file to run the installation file. When prompted, click on ‘Run’
to start the installation.

Open File - Security Warning =
Do you want to run this file?
@ Name: ..ocuments\Firefox[1]\Firefox Setup 17.0.11 esr.exe
Publisher: Mozilla Corporation

Type: Application
From: C\Users{giiill O o cuments\Firefox[1]\Firefox ...

[ Run ] [ Cancel

Always ask before opening this file

I = | While files from the Intemet can be useful, this file type can
N ” potentially ham your computer. Only run software from publishers
- you trust. What's the risk?

The Firefox installation will now start.



.
1) Mozilla Firefox Setup —m|mi=k

Welcome to the Mozilla Firefox
Setup Wizard

This wizard will guide you through the installation of Mozilla
Firefox,

It is recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

[ MNext > ] [ Cancel

After Firefox has finished installation, open Firefox if it has not launched automatically

Firefox = o =
w Mozilla Firefox Start Page | + -
& w about:home ‘ "'CJI;"GUDQIE P]|*||E'|

-

Search

Gougle

{ Want an Android browser as
smart as your desktop browser?

Install Firefox for Android!

Restore Previous Session

About Mozilla

Set Up Sync Pair a Device

L |




3.4 Block Firefox Update

This step is to be run right after the installation in order to block the update.

3.4.1 Firefox Navigation Bar

In Firefox click on Firefox - Options - Options

(| Firefox =

New Tab ¥ 7 Bookmarks F

1% New Private Window History 4 ‘
dexjsp

; N Downloads

. ent System Workspace, Fusion Edition

Find... & Add-ons

Save Page As... Options ' Options

Hel 4
Email Link... =t Menu Bar
3

& Print.. ¥ Navigation Toolbar

Web Developer 4 Bookmarks Toolbar

Full Screen Add-on Bar  Ctrl+/

Set Up Sync..,
B Exit

Toolbar Layout...

3.4.2 Firefox Menu Bar

In Firefox click on Tools = Options

@ Mozilla Firefox Start Page - Mozilla Firefox
File Edit View History Bookmarks Help

|® Mozilla Firefox Start Page Downloads Ctrl+)
- - Add-ons Ctrl+Shift+A
Go to a Website
Set Up Sync...
|21 Most Visited i | Getting Started [ Web Developer R
Page Info

Start Private Browsing Ctrl+5hift+P
Clear Recent History... Ctrl+5hift+Del

Options

Under Advanced - Update select “Never check for updates...” and click OK



0o &8 & ® 8 O

General Tabs Content  Applications  Privacy  Security Sync

Generall Data Ch::-icasl Neh\fc-lk| Update | ertificates

Firefox updates:
() Automatically install updates (recormnmended: improved security)

[¥] Warn e if this will disable any of my add-ons
(7 Check for updates, but let me choose whether to install them

Mever check for updates (not recommended: security risk]

| Show Update Histary ]

Autornatically update:
Search Engines

| ok || cance ||

Help




3.5 Install Add-on

3.5.1 Firefox Navigation Bar
Click on Firefox > Add-ons

N [=]
MNew Tab 4 ffﬂodmarks LTS -
@Sizrt Private Browsing History 3
Downloads ¢ -.'v Google ,O| 1 n-
it [ 4 N
=
— P Options 3
ve Page As... "
Send Link... i
= Print... »
Web Developer 3
Full Screen
Set Up Sync... Search
B3 Exit
Want an Android browser as
smart as your desktop browser?
Install Firefox for Android!
Restore Previous Session
About Mozilla
Set Up Sync Pair a Device =l
3.5.2 Firefox Tool Bar
Click on Tools - Add-ons
Mozilla Firefox Start Page - Mozilla Firefox
File Edit View History Bookmarks |Io-o|s Help
|® Mozilla Firefox Start Page Downloads Ctrl+]
- = Add-ons Ctrl+5Shift+A
¥ o 1 i 51
B Set Up Sync...
18) Most Visited {_| Getting Started [ Web Developer b
Page Info

Start Private Browsing Cirl+5hift+P
Clear Recent History... Ctrl+Shift+Del

Options

On the Add-ons screen click the “Settings” (cog) icon, and select

“Install Add-on From File...”



Firefox ~ -1ol x|

-* Add-ong Manager =

| @ 9 | I Search all add-ons
Check for Updates
View Recent Updates

v Update Add-ons Automatically
Add-ons are apg

Firefox with ext
time-saving sidebar, a weather notifier, or a themed
look to make Firefox your own.

Reset All Add-ons to Update Automatically

{' What dali Install Add-on From File...

First time with Add-ons?
Check out our interactive video to

learn about some of the awesorme
things you can dowith add:onst

Watrh the Vidan

Here is where you will install the Remote XUL manager. In the browse window select
the location of the file

‘remote_xul_manager-1.2.3-an+fn+fx+sm.xpi” and click “Open”.

S
. S—

| @ » Vladimir Dragovic » Downloads Search Downloads }J|

Organize * New folder =~ 0 @
-
S Favorites *  MName Date modified Type
Pl Desktop || remote_xul_manager-1.0.1-sm+fxxpi 1/16/2014 9:39 AM  XPIFile
& Downloads

E Dropbox
“Zl Recent Places

m

) Libraries
@ Documents
J‘ Music
[ Pictures =

B Videos

ﬁ Homegroup

L 11 | 3

File name: remote_xul_manager-1.0.1-sm+fx.xpi » |Add-ons -




In the Software Installation box wait for few seconds for the “Install Now” button to
appear, then click “Install Now”

x
LY Install add-ons only from authors whom you trust.

\J Malicious software can damage your computer or violate your privacy.

You have asked to install the following item:

* Remote XUL Manager (Awthor not verffied])
file: fi{C: fUsers/GaricSt/Dropbox EDU % 20Phase %20 1/99 % 2050 ftware fremote _xul

Install Mow Cancel

Once the install is completed, a message to restart Firefox will appear. Click

“‘Restart Now” and wait for Firefox to reopen.

Firefox ~ o [m] 1|
Dmﬂaﬁeﬁusmm x I & Add-ons Manager X| + -
|('-'|I "’| Remote XUL Manager will be installed after you restz
Firefox,

What a.r FIA UTT2,

Add-ons are applications that let you personalize I |
Firefox with extra functionality or style. Try a —
time-saving sidebar, a weather notifier, or a themed

look to make Firefox your own.

=
"
-

First time with Add-ons?
Check out ouninteractive video {o

[Eani abo U some ot therawesornme
things you can dowith add-ons!

Watch the Viden




3.6 Set URL

3.6.1 Firefox Navigation Bar

Once the browser restarts, go to Firefox > Web Developer > Remote XUL Manager

I=IE

New Tab ¥ |7 7Bookmarks » | E
2% start Private Browsing History 3 =
Downloads c "' ~ Google e | o B
=i 3 L — |
-
Find... ¢ Add-ons =
Options »
Save Page As...
Help 3
Send Link...
= Print... »
Web Developer Web Consale Ctrl+Shift+k
Full Screen Inspect Ctrl+Shift+
Set Up Sync... Sk LrETELE : Search
Exit Scratchpad Shift+F4
View Page Source Cirl+J
D Error Console Ctrl+5hift+3 oid browser as
esktop browser?
Get More Tools :
o for Android!
Character Encoding 3
Work Offline
(9 | Restore Previous Session
About Mozilla

Set Up Sync Pair a Device

3.6.2 Firefox Tool Bar
Tools - Web Developer > Remote XUL Manager

Morzilla Firefox Start Page - Mozilla Firefox
File Edit View History Bookmarks IIooIs Help

|® Mozilla Firefox Start Page Downloads Cirl+]
~ 5 5 Add-ons Ctrl+Shift+A
P Go to a Website Set Up Sync...
[Bh Mast Visited [} Getting Started 5 Web Developer o Pomre Tellen Shift2E2
Page Info Web Console Ctrl +Shift+K
Start Private Browsing Ctrl+Shift+P Inspect Ctrl+Shift+1
Clear Recent History... Ctrl+Shift+Del Responsive Design View  Ctrl+Shift+M
X Debugger Ctrl+5Shift+5
CoTeTons Scratchpad Shift+F4
Style Editor Shift+E7
Page Source Ctrl+U
Error Console Ctrl+Shift+J

Remote XUL Manager

Get More Tools

B, 2 A TTmaann

In the XUL manager menu click “Add”, then paste in the planning URL
https://efis.fma.csc.gov.on.ca/workspace/index.jsp and click OK

11


https://efis.fma.csc.gov.on.ca/workspace/index.jsp

. S .
Add domain | S

0_. Enter the full domain you want to add, like "www.mozilla.com" (or "<file>" for local files):
-

https//efis.fma.csc.gov.on.ca/workspace/indexjsp

0K l ’ Cancel

E

The address will now appear in the list of domains. Close out of this window by clicking
on “X” on the right corner window.

Domains with remote XUL permission:

efis.fma.csc.gov.on.ca

Add... Bemowe
| |
E e r

Once in Firefox, paste the same URL into the address bar and hit Enter. Firefox will
block a popup and will not allow for the application to open. Click the “Options” button
and “Allow pop-ups for ...”

12



~Ioix]

. Oradle Enterprise Performance Management... | + =

(- :: gov.on.@a | https://test.efis.fma.csc.gov.on.@fworkspac r'o ¢ '." Google P| f n'

E Firefox prevented this site from opening a pop-up window. Options | x |
Allow pop-ups for test.efis.fma.csc.gov.on.ca
Edit Pop-up Blocker Options..

Don't show this message when pop-ups are blocked

Show 'hitps: test.efis.fma. csc.gov.on. cajworkspace findex. jsp?ramed =true"

If the application does not open automatically, re-paste the URL and open the
application.

GO Secure logon screen will appear. This step is now complete.

8 GO Secure Login - Windaws Internet Explorer - - =@ 8]

@ [ nttpsis ty. o/ golD/accessfindexjsplauthn,_try_count=08contextT ontextValue="%

T Favorites 5% ffil Education Act- O. Reg.13... fff] Education Act - O.Reg.13.. ] Web Slice Gallery v
6O Secure Login | | % - - & @ v Page~ Safetyw Tools~ @+

A18[4[x| B 5~

4

P’P Frangais
V Ontario

( G)SECURE Sign In
LOGIN
GO Secure ID
Providing secure online resources for individuals within the
Ontario and Broader Public Sectors. Password
Don't have an account?

—

Forgot your ID o password?

GO Secure Profile
(See your profile, change password or security questions)

GO Secure Login - Delegated Administration
(For administrators of user access and resources

CONTACT US | ACCESSIBILITY | PRIVACY | HELP © QUEEN'S PRINTER FOR ONTARIO, 2012 | IMPORTANT NOTICES | ENV ID: UAT
LAST MODIFIED: 2013-11-21




3.7 Adobe settings in Firefox

3.7.1 Firefox Navigation Bar

In Firefox go under Options

“Firefox"=" ] | Qracle Enterprise Performance Manage... | -+ m

New Tab b 57 Bookmarks ¥ P
¥¥  Start Private Browsing History » =
= o Divinlosds oc Set Cycle | | EFIS-Dev | | Efis-Prod
: nt System Workspace, Fusion Edition
Find... # Add-ons '
Save Page As.. Options » Options
il Link...
. Frrat s Fielp : Menu Bar
int... »
& Print ¥ | Mavigation Toolbar
Web Developer 4 v Bookmarks Toolbar
Full Screen Add-on Bar Ctri+/
Set Up Sync... Toolbar Layout..,
Iu £ Password:
3.7.2 Firefox Menu Bar
In Firefox click on Tools - Options
w Mozilla Firefox Start Page - Mozilla Firefox
Eile Edit View History Bookmarks |Ioo|s Help
‘e) Morilla Firefox Start Page Downloads Ctrl+)
- e Add-ons Ctri+Shift+A [
% Go b fesii
T ¢ Set Up Sync...
[8) Most Visited [ Getting Started = Web Developer ,
Page Info

Start Private Browsing Ctrl+5Shift+P
Clear Recent History... Ctrl+5Shift+Del

Options

Under Applications make sure that everything under the Adobe Acrobat has “Use
Adobe Acrobat (in Firefox)”

14



Options

et

d & =5 P&

General Tabs Content ~ Applications  Privacy  Security Sync Advanced

o a8 Q

‘E Adobe Acrobat Forms Docurmnent (appli
i Adobe Acrobat Forms Docurment (appli
"E Adobe Acrobat XML Data Package File
& irc

a ircs

a mailto

E Podcast

E Video Podcast
3] Web Feed

& webcal

Search 2
Content Type *  Action
'E] Adobe Acrobat Document l i Use Adobe Acrobat (in Firefox) -

= Use Adobe Acrobat (in Firefox)

ﬂ Use Adobe Acrobat (in Firefox)
B Use Adobe Acrobat (in Firefox)
(o Always ask

l,T—| Always ask

|77 Use Microsoft Outlook (default)
l,T—| Preview in Firefox

l,T—| Preview in Firefox

L7l Preview in Firefox

(o Always ask

[Coc ] [Lome] [Lue ]

15



4 Internet Explorer setup

4.1 Recommended Version

Internet Explorer 9 (IE9) is the recommend version for use with Oracle Hyperion
Planning.

IE8 is also compatible. However, users may experience performance degradation in
data entry activities using IE8. Therefore, it is not recommended.

IE10, IE11, Chrome and Safari are not yet supported and should not be used.

4.2 |E Setup — Mandatory

Specific |E settings are recommended by Oracle for the Hyperion products.

4.2.1 Disable default pop-up blocking
e Open Internet Explorer

e Go to “Tools“--> “Internet options“--> “Privacy” tab

e Uncheck "Turn on Pop-up Blocker"

Internet Options @

| General I Security| Privacy |C0ntent | Connections I Programs | Advanced|

Settings

To set a standard privacy level instead of using custom
settings, click the Default button.

Custom

- Advanced or imported settings

Sites ] | Impaort | | Advanced | | Default |
Location
' Mever allow websites to reguest your Clear Sites
physical location

Pop-up Blocker

| Turn on Pop-up Blocker Settings

InPrivate

| Disable toolbars and extensions when InPrivate Browsing starts

0K | | Cancel




4.2.2 Customize security settings

e Open Internet Explorer

e Go to “Tools"--> “Internet options” --> “Security“ Tab

e Select Custom Zone containing your Oracle Hyperion servers and click on

"Custom level..." button

Internet Options @

General | Securty | Privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & v 0O

Internet  Local intranet Trusted sites  Restricted
sites

Internet

Q This zone is for Internet websites,
except those listed in trusted and
restricked zones.

[¥5]
=
[1:]
[

Security level for this zone

Custom
Custom settings.
- To change the settings, click Customn level.
- To use the recommended settings, click Default level.

[T]Enable Protected Mode (requires restarting Internet Explorer)
Default level ]

[ Custom level... ]

[ Reset al zones to default level I

[ oK J [ Cancel ] ’ Apply ]

In "ActiveX controls and plug-ins" section enable "Run ActiveX controls and plug-

ins" and "Script ActiveX controls marked safe for scripting".

17



Security Settings - Internet Zone @

Settings

@ Disable (recommended) ~
) Enable (not secure)
@ Prompt

\#| Only allow approved dormains to use ActiveX without prompt
) Disable
@ Enable

Run ActiveX controls and plug-ins

() Administrator approved

m

©) Prompt
¥ Script ActiveX controls marked safe for scripting®

% Downloads
e Fila downlnad i N
« n v

*Takes effect after you restart Internet Explorer

Reset custom settings

Resetto!  [wedum-high (default) =] [ Reser.. |

l oK ] [ Cancel I

"ActiveX controls and pug-ins" allow workspace to open

¢ In "Miscellaneous" section enable options "Access data sources across domains"
and "Allow script-initiated windows without size or position constraints”

Security Settings - Internet Zone @

Settings

| Miscelaneous o
|| Access data sources across domains
O Disable
@ Enable
@ Prompt
| Allow META REFRESH
) Disable
@ Enable
| Allow scripting of Microsoft web browser control

m

| Allow script-initiated windows without size or position constraint
) Disable
@ Enable <:=
|| Allow webpages to use restricted protocols for active content
) Disable
(™)_Fnahle 2

< n »

*Takes effect after you restart Internet Explorer

Reset custom setfings

Reset t0:  [wedum-high (default) ~] [ Reset. |

[ oK ] [ Cancel ]

The "Access data sources across domains” and "Allow script-initiated windows without
size or position constraints” allow proper menu display

18



4.2.3 Disable option "Do not save Encrypted Pages to Disk"

e Open Internet Explorer

e Go to “Tools” --> “Internet options” --> “Advanced” Tab. In "Security" section
uncheck the option "Do not save Encrypted Pages to Disk".

Internet Options @

| General | security | Privacy | Content | connections | Programs | Advanced

Settings

Shaw pictures A
% Security

[ Allow active content from CDs to run on My Computer®

[[] Allow active content to run in files on My Computer®

[C] Allow software to run or install even i the signature is invalid

[7] Block unsecured images with other mixed content

Check for publisher's certificate revocation

Check for server certificate revocation™®

Check for signatures on downloaded programs
C [] Do not save encrypted pages to disk

[] Empty Temporary Internet Files folder when browser is close =

Enable DOM Storage

Enable Integrated Windows Authentication™

Enable memory protection to help mitigate online attacks™

[7] Enzble native XMLHTTP support 2
4 n 3

*Takes effect after you restart Internet Explorer

Restore advanced settings ]

Reset Internet Explorer settings

Resets Internet Explorer's settings to their default
condition.

You should only use this if your browser is in an unusable state.

oK l I Cancel

4.2.4 Configure browser NOT to use Compatibility View

e Open Internet Explorer
e Go to “Tools” --> “Compatibility View".

e Make sure that all checkboxes are Unchecked



Compatibility View Settings (3]
You can add and remove websites to be displayed in

() Compatibiity View.

Add this website:

‘Websites you've added to Compatibility Views:

[[Jindude updated website lists from Microsoft
[7] Display intranet sites in Compatibility View
["] Display all websites in Compatibility View

Close

4.3 |E Setup —- Recommended

4.3.1 Add Workspace URL to trusted sites
e Open Internet Explorer

e Go to “Tools"--> “Internet options“--> “Security” tab

e Select "Trusted sites" from "Select a zone to view or change security settings"
window, then click on "Sites" button.

Internet Options @I

| General| Security | privacy | Content | Connections | Programs | Advanced |

Select a zone to view or change security settings.

@ & v/ 0

Internet  Local intranef] QICEEEREEEE | Restricted

sites
Trusted sites =
es
9 This zone contains websites that you
v trust not to damage your computer or
your files.

You have websites in this zone.

¢ In "Add this website to the zone” enter the following URL.:
https://efis.fma.csc.gov.on.ca

e Uncheck "Require server verification (https:) for all sites in this zone"

20


https://efis.fma.csc.gov.on.ca/

Trusted sites * ﬁ

# You can add and remove websites from this zone. All websites in
& this zone will use the zone's security settings.

Add this website to the zone:
https://efis.fma.csc.gov.on.cafworkspace/index.jsp

Websites:
https: //*.ontario.ca -
https://*.ontario.ca

https: //*.projectcentre.jus.gov.on.ca
https: ffefis. fma.csc.gov.on.ca

| PO | T Y S T S S T

A
Ir|_|

=]

T

-

|| | Require server verification {https:) for &l sites in this zone

Close

e Click Add, then Close.
e Click OK

Repeat for the following URLS (if they are not already entered)
e *.gov.on.ca

e http://*.gov.on.ca

4.3.2 Minimize security setting for trusted sites

e Open Internet Explorer
e Go to “Tools" --> “Internet options” -->“Security” tab

e Select "Trusted sites" from "Select a zone to view or change security settings"
window

e Select Custom level

21


http://*.gov.on.ca/

Internet Options

General | Security | privacy | Content | Connections | Programs | Advanced

Select a zone to view or chgnge security settings.

@ &l v/ |0

Internet  Local intrane QITEEEE | Restricted
sites

Trusted sites —
J This zone contains websites that you
h trust not to damage your computer or

your files.

You have websites in this zone.

Security level for this zone

Custom
Custom settings.
- To change the settings, click Custom level.
- To use the recommended settings, click Default lavel.

[ Enable Protected Moge{requires restarting Internet Explorer)

I Custom level... Default level ]

[ Reset all zones to default level ]

ool
¢ From dropdown button menu under the Settings window, select "Reset to:" Low

e Click on Reset, then click OK

Security Settings - Trusted Sites Zone

Settings

&% .NET Framework
&% Loose XAML
) Disable
Enable
) Prompt
&% XAML browser applications
[

>

© Prompt
B .NET Framework-relant components
e Permissions for components with manifests

*Takes effect after you restart Internet Explorer

Reset custom settings

Reset to:  (Medium (default) -] [ Reset... <:
Medium (default) -
Mediurm-low

-
. j Cancel




4.3.3 Enable Mixed Content

e Open Internet Explorer
e Go to “Tools" --> “Internet options” -->“Security” tab

e Select "Trusted sites" from "Select a zone to view or change security settings"
window

e Select Custom level

Internet Options @

Geneml| Security |Privacy | Content| Connect»ons| Programs | Advanced\

Select a zone to view or chgnge security setfings.
Y y S

v
Internet  Local intranef QITEEHEEY | Restricted

sites
i
," This zone contains websites that you
4 trust not to damage your computer or
your fles.

You have websites in this zone.

Security level for this zone

Custom
Custom settings.
- To change the settings, click Custom level.
- To use the recommended settings, click Default level.

[ Enable Protected Moge{requies restarting Internet Explorer)

I Custom level... Default level ]

[ Reset all zones to default level ]

¢ In Miscellaneous section under “Display mixed content” -> changed from
“‘Prompt” to “Enable” then clicked on “OK”



F-

Internet Options

[IES

g

|

Security Settings - Trusted Sites Zone

Settings

|| Allow webpages to use restricted protocols for active conten -

() Disable

A
11
s

Cle
m
=]
o
=N
m

Prompt
llow websites to open windows without address or status b

=
ol
("]
fu
=
m

o=~
() L0
R

Enable

|| Display mixed content
(") Disable Ml

:

) Prompt

|| Don't prompt for dient certificate selection when only one ce
@ Disable
() Enable

|| Drag and drop or copy and paste files

T Nieshla )
1 | ] 3

*Takes effect after you restart Internet Explorer

Reset custom settings

Reset to: Medium {default) v] [ Reset... ]
[ oK ] [ Cancel ]

l AT J l T T J TR

Repeat the above procedure for the “Internet” zone

o Select Custom level

o In Miscellaneous section under “Display mixed content” -> changed from

“‘Prompt” to “Enable”

o Click on “OK”
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Internet Options @

General | Security |Pri'u'ac5-' I Content | Connections | Programs | .ﬁ.duanced|

Select a zone to view or change security settings.

@& v O

Local intranet  Trusted sites  Restricted
sites

Internet

) . ) Sites
@ This zone is for Internet websites,

except those listed in trusted and
restricted zones.

Security level for this zone

Custom

Custom settings.
-To change the settings, dick Custom level,
-To use the recommended settings, dick Default level.

Enable Protected Mode (requires restarting Internet Explarer)

Custom level. .. H Default level ]

[ Reset all zones to default level ]

.ﬁ. Some settings are managed by your system administrator,

[ Ok J [ Cancel ] Apply

4.3.4 Configure browser to check for new version every time user visits a page

e Open Internet Explorer
e Go to “Tools“--> “Internet options“--> “General*

e In "Browsing history" section click on "Settings" button and then select "Every
time | visit the webpage" option

e Click Apply then OK
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E

I"z2

Internet Options

General | Se(urrtyl Privacy | Conteﬂtl Connections | Programs | Advanced

Home page Temporary Internet Files and History Settings @
To create home page tabs, type each address on its own line.
B |4 Temporary Intemet Files
hetp:/f google.cal T Internet Explorer stores copies of webpages, images, and media

for faster viewing later.

Check for newer versions of stored pages:

l Use current I [ Use default ] l Use blank @ Every time I visit the webpage
(7 Every time I start Internet Explorer

Browsing history

4L ) Delete temporary files, history, cookies, saved passwords, and ‘:'Automatlljlly
¥ web form information. © Never
Disk space to use (8-1024MB) 250 =

[] Delete browsing history on exit
(Recommended: 50-250MB)

Delate. ]Ill Seitngs Ill Current location:
. C:\Users\Bryan\AppData\Local\Microsoft\Windows\ Temporary
(’;‘ Change search defaults. Intemet Files\
7
Tabs [ Move folder... ] [ View objects ] [ View files
Change how webpages are displayed in
tabs. History
Appearance Specify how many days Internet Explorer should save the list of
websites you have visited.
Colors ] [ Languages ] [ Fonts ] [ Accessibility ] Days to keep pages in history: 20

4.3.5 Enable option "Always allow session cookies"

e Open Internet Explorer

e (o to “Tools"--> “Internet options“--> “Privacy“ --> “Advanced”. Check the
"Override automatic cookie handling", accept the first and third party cookies and
check the "Always allow session cookies" option.

e Click OK

Internet Options | % H &3 |

| Generall Securty| Privacy \Contentl Connections Prograrmlhdvanced|

Settings

To set a standard privacy level instead of using custom
settings, click the Default button.

Custom
- Advanced or imported settings Advanced Privacy Settings @
[} *You can choose how cookies are handled in the Intemet
_a zone. This overides automatic cookie handling.
Cooldes
> [¥] Overmide automatic cookie handling
[ Sites ] [ Import I [ Advanced I [ Default ]
Location First-party Cookies Third-party Cookies
7 Never allow websites to request your Clear Sites E>° by E>° ey
physical location () Block () Block
() Prompt () Prompt

Pop-up Blocker
Always allow session cookies

[ Turn on Pop-up Blocker Settings :

InPrivate

Disable toolbars and extensions when InPrivate Browsing starts

oK I [ Cancel Ap
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Prevents unwanted time-outs (logouts); Recommended if user gets logged out from the
application too often and too soon
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5 Smart View
To use the Smart View add-in you must be using Microsoft Office 2007, 2010 or 2013.

If you only have access to MS Office 2003 please contact efis.support@ontario.ca for
instructions.

You need to have Administrator rights to install Smart View. Please contact your local IT
support desk to provide the Administrator access.

5.1 Download File
There are two methods of installing Smart View.
Method 1 — From a zip file:

https://efis.fma.csc.gov.on.ca/SmartView/SmartView.zip

Copy or type in the above URL and press Enter. The following screen will appear.

i '

File Download P

Do you want to open or save this file?

F Mame: SmartView.zip
Type: Compressed [zipped) Folder, 135MEB

From: efis.fma.csc.gov.on.ca

Qpen I I Save J I Cancel

I | While files from the Intemet can be useful, some files can potentialhy
a harm your computer. f you do not trust the source, do not open or
= save this file. What s the risk?

If you Save the file, once it has been downloaded, proceed to open it.

If you decided to Open the file, or to Save it, the following screens are the same.

Name Type Compressed size Password ...  Size Ratio Date modified

= SmartView Application 138801 KB No 139801 KB 1% 01/17/2014 2:41 PM

Double click on the Smart View icon to run it.

You will be prompted to run the file, click on Run.
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https://efis.fma.csc.gov.on.ca/SmartView/SmartView.zip

Open File - Security Warning Iﬁ

Do you want to run this file?
@ Mame: ..alhTemp\Templ_SmartView[l].zip\SmartView.exe
Publizher: Oracle America, Inc.

Type: Application
From: ChUs Ers"-,-J‘-,AppData‘-.Ln cal\Temp\Templ_5...

[ Fun ] [ Cancel

‘~| While files from the Intemet can be useful, this file type can
e,. potentially ham your computer. Onby run software from publishers
- you trust. What's the risk¥

|
k-
-

Open your Excel to ensure that the Smart View tab is present. Continue with step 6.2.
Method 2: From Within EFIS

Access the EFIS application as usual. Once you are signed in, click on “Tools’ -> ‘Install’
-> ‘Smart View’.

T S - - - «

e‘\ )| @ nitps://efisfma.csc.govion.ca/workspace/indexjsp -acx|@o ]

File Edit View Favorites Tools Help

x Google + [#9 Search - |- 5 Share | More >

ORACLE' Enterprise Performance Management System Workspace, Fusion Edition

Navigale File View Favortes Tools Help

[shared Workspace Pages{HomePage

m Recently Opened )/ Quick Links

E@Tabeswa ] Faverites

The following dialogue box will appear.
Click on ‘Run’ to install the software now or ‘Save’ to save the program and install later.
If any pop-up screens show up during the installation, click on ‘Run’.

You will be prompted for the Administrator name and password. Please enter them to
continue with the installation.

Follow the next steps to complete the installation.
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Smart View Installation

Initiate the Smart View install by navigating to the folder where you downloaded the file
and then double clicking the SmartView.exe file.

Cracle Smart View for Office Installation ﬁ

Select destination folder for Oracle Smart View

Ch\Oracle\SmartWiew C]

| ok || cance |

e Select your destination folder and, click OK.

5.2 Verify the installation

The next step is to open Excel and check that the Smart View Tab is visible in toolbar.

E—-II = |= Bookl - Microsoft Excel

File Home Insert Page Layout Formulas Data Review View Smart View

= 1d . ) Undo Data Point @ @ ﬁlg P Help ~
L —
il & Redo ata Point U= & sheet Info
Panel Connections Refresh | Submit | Options
= Elj Functions ~ S Data El more ~

Start Edit Data General
X} - £
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5.3 Setting up the connection

In Smart View, go to Options, Click on Advanced and specify the shared Connections

URL:

https://efis.fma.csc.gov.on.ca/workspace/SmartViewProviders

Logging
Log Message Display
[T Route Messages to File
Clear Log File on Next Launch
Display
Language
[ Display Smart View Shortcut Menus Only
[ Disable Smart View in Outlook
Enable Ribbon Context Changing

[T Display Drill Through Report ToalTips
Compatibility

Reduce Excel File Size

D Improve Metadats storage

Mode
Use Double dick for Operations

- e e e
Options =
Member Options % Change global Smart View options,
Data Options
op General -
Advanced I Shared Connections URL: htm:,.’ﬂnua‘dlv.frna.csc.gov.an‘ca: 19000/work + I
. MNumber of Undo Actions g =
Formatting =
MNumber of Most Recently Used items
Cell Styles
[ Delete Al MRU Items ]
Extensions

[Errors

v].__.

‘ i '-Llsers'-xucl'-AppData'-Roammg‘-.Oracle'-Smart'-.a‘le'f\"-.‘ =

(Englsh

z)

Disable options that are not valid for the active connection

[T1Refresh Selected Functions and their dependents

5.4 Setting up the Options in Smart View

To access the Options click on Smart View — Options

X 9 - o -5 okl - Microsoft Exce
m Home Insert Page Layout Formulas Data Review View Developer Add-Ins
Ly nda By Data Point = -
:l - £} Undo oint @ @ o= Help
\—. e Red ‘_1;":; te Data Point u= Sheet Infa
Panel Connections Refresh | Submit § Options
- Functions = - Data =l More ~
Start Edit Data neral
3
4
5

Under Data Option remove the check marks from following boxes under Suppress

Rows and Columns.
[ ]

No Data/Missing

e Zero
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e No Access

rOptinns l - — u‘

Member Options E;: Change Smart View options related to grid rows and columns,

Data Options ‘ S 0

Advanced [ No Data | Missing
Formatting Zero

Mo Access

[ 1nvalid

- [ Underscore Characters
[ | repeated Members
Suppress Columns (i) |
No Data / Missing

Zero )

Mo Access (f)

Replacement @
#MoData/Missing Label: #Missing -

Cell Styles

I #MoAccess Label: #ho Access -

#rvalidMeaningless: #Invalid - |

[ submit zero

[ Display Invalid Data
[/] Enable Essbase Format String |
ke 0
Cell Display Data - |
Navigate Without Data

Suppress Missing blocks

e )= o J[ oo |

After you make changes if any, click on the arrow beside OK and select Save as default
option.
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Cell Styles
[ Delete Al MRU Items ]
Extensions me @
I Log Message Display lErrors 'I
[ Route Messages to File | C: ||,|_Is;ers;'|,c|rago\r\t|'|,~!k|3|3Data'||Roaming'|,0rade'nSmart\| Query
Clear Log File on Next Launch
Display @ | ool Level Enro
: 1f12 & 13 Enrol
lish
g lEng| 'I \[tions - Inpu
[ isplay Smart View Shortcut Menus Only \[endices - Inpi
[ Disahle Smart View in Outiook 1 1-Def§:rrr
| '} 3.2-Capital
Enable Ribbon Cantext Changing 11 3.1 - Capitsl
Disable options that are not valid for the active connection 3 -CaptalE
'} 3.3 -Capital
[ Display Drill Through Report ToolTips b 34 - Capitz
Compatibilty G (...
Reduce Excel File Gize |
[ improve Metadata storage
[ |Refresh Selected Functions and their dependents
Mode
Use Double dick for Operations

Save as Default Options

Last step is to close excel and reconnect again, to make sure all the changes took
effect.
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